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It’s in Your Back Pocket! 

Attaining Accessibility With Tools You Already Have 
 

Use the technology tools already in your schools to make the general 

education curriculum accessible for all students 

Microsoft Word, Windows 7, and other simple software programs can be 

used to accommodate students with a wide range of abilities  

 

A continuum of learner differences
Adjustments for all students
Varied and diverse curriculum materials 
General curriculum should be made 
flexible to accommodate learner 
differences 

 

 Students with disabilities, just like all students, fall along a continuum 

of learner differences and do not constitute a separate category  

 Teacher adjustments for learner differences should occur for all 

students, not just those with disabilities  

 Curriculum materials should be varied and diverse including digital and 

online resources, rather than centering on a single textbook  

 Instead of remediating students so that they can learn from a set 

curriculum, curriculum should be made flexible to accommodate 

learner differences  
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Multiple means of representation

Multiple means of expression

Multiple means of engagement

 

UDL 

 Multiple means of representation, to give learners various ways of 

acquiring information and knowledge 

 Multiple means of expression, to provide learners alternatives for 

demonstrating what they know 

 Multiple means of engagement, to tap into learners' interests, offer 

appropriate challenges, and increase motivation.  

Simplify things visually

Right-click the Ribbon  select Minimize the Ribbon 

Use the to maximize/minimize the Ribbon  

Minimize the Ribbon 
 

Minimize the Ribbon to visually simplify the screen  

•Right-click the Ribbon  Select Minimize the Ribbon 

•Click any tab to view the Ribbon 
 

Maximize the Ribbon: 

•Right-click the Ribbon  Deselect Minimize the Ribbon  
 

Alternative:  You can also use the  in the right corner of the ribbon to  

maximize/minimize. 

Right-click the Ribbon 
select Customize the Ribbon

Tab Group

 

Customize the Ribbon 

 

Create new tabs, new groups and rearrange the default  

•Right-click the Ribbon  Select Customize the Ribbon 

•Click on New Tab to create a new tab 

•Click on New Group to add a group to an existing tab 

 

*Suggestion:  Create a customized tab with student’s name and add only 
buttons he/she uses. 



Show only buttons and commands needed

Right-click a Command  Add to 
Quick Access Toolbar  OR 

Customize Quick Access Toolbar

QAT pull-down 
menu  More 

Commands

Right-click QAT  Show Quick Access Toolbar Below the Ribbon

 

Customize the Quick Access Toolbar (QAT) 

Make the Quick Access Toolbar “user friendly” for students. Add the 

commands needed by students and move the QAT below the Ribbon. 
 

Add commands to the QAT: 
•Right-click a command on the Ribbon  Add to Quick Access Toolbar 

OR 

•QAT pull-down menu  More Commands  Select and add commands  

•File Tab Options  Quick Access Toolbar  Select and add 

commands 
 

Move the QAT below the Ribbon: 
•Right-click the QAT  Show Quick Access Toolbar Below the Ribbon 

White background – Black font Yellow background – Black font 

Red background – Yellow font Blue background – White font   

Page Background & Font Color    

Change the background color: 
•Page Layout Tab  Page Background  Page Color 

Change the font color: 
•Home Tab  Font  Font color   

  

ADD: Try yellow text on red background 

Confuse similar words: Try rose or red background 

Dyslexia: Try black text on dark blue background 

Trebuchet

The quick brown fox jumps 

over the lazy dog.

Comic Sans

The brown fox jumps over 
the lazy dog. 

Arial

The quick brown fox jumps 

over the lazy dog. 

Verdana

The quick brown fox 
jumps over the lazy dog.

Preferred fonts for students with learning disabilities have appropriate 
letter spacing, large body size, high ascenders, and low descenders, and 
notable shape differences between the letters, "o, a, b, d, p, q".

Home Tab  Font  Font

Minimum font size  12 pt

 

Select Fonts for Readability 

•Home Tab  Font  

Preferred fonts for students with learning disabilities have appropriate 

letter spacing, large body size, high ascenders and low descenders, and 

notable shape differences between the letters, "o, a, b, d, p, q". 

A minimum font size of 12 point is recommended. 

 

Note: The Times New Roman font used by Microsoft Word is actually one 

of the hardest to read for a student with dyslexia. 

Decreases the amount of visual tracking a student must do

standard margins

increase left and 
right margins 

Page Layout Tab 
Margins 

 

Increase the Margins  

Increase margins to decrease the amount of visual tracking a student 

must do. Guidelines suggest keeping line lengths down to 12 words on 

average. 

•Page Layout Tab  Page Setup  Margins  Custom Margins 

•Increase the left and right margins to 2” or desired width 
 

Note: Your custom margin settings will appear as a choice (Last Custom 

Setting) next time you select the Margins command. 

Improve visibility and visual tracking

Home tab  Paragraph 
 Line spacing

 

Line Spacing      

Home tab  Paragraph  Line spacing 

 

Increase the space between lines to improve visibility and visual tracking. 

 



create a template completed template table  text

 
Tip: Tables to text can also be 

used when writing a 5 paragraph 

essay.  Create a template where 

students write one paragraph in 

each box. 

Tables to Text Paragraph Writing 

Insert Tab  Tables  Table  Select number of rows and columns 
 

•Create a paragraph template (Column 1: types of sentences in a 

paragraph – Topic, Detail, Concluding; Column 2: cells for students to type 

the appropriate sentence) 

•Students type sentences in the appropriate cells in Column 2 

•Position the cursor over the column containing the sentences  cursor 

changes to an arrow  click to select the column  copy (Home Tab  

Clipboard  Copy) 

•Open a new document or position the cursor below the table  Paste 

•Select the column  Table Tools  Layout Tab  Convert to Text  

Click OK 

•Students revise and edit the paragraph. 

 

Outline view 

Print view 

Final version 
Outline Template 

Outlining Tab

View tab  Outline

 
Tip: Do not minimize the ribbon 

when working in the Outline View 

or the ribbon will cover part of the 

text when accessing the outline 

tools. 

Outline View  

View Tab  Document Views  Outline  
 

Use the Outline View to create an outline for a writing project. 

Templates may be created with paragraph writing prompts. 

•Type main ideas 

•Move ideas up and down by clicking and dragging the + or – signs 

•Expand /Collapse each section by double-clicking the + or – signs 

•ALT−SHIFT−LEFT ARROW promotes the text 
•ALT−SHIFT−RIGHT ARROW demotes the text 
•ALT−SHIFT−UP ARROW moves text up 
•ALT−SHIFT−DOWN ARROW moves text down 
 

Return to Print View (View Tab  Document Views  Print Layout). Clear 

the formatting: 

•Select all text  

•Home Tab  Font  Clear Formatting 
 

Revise and edit 

Insert tab  Illustrations 
SmartArt 

 

SmartArt (Diagrams)  

Insert tab  Illustrations  SmartArt 
 

•Choose a SmartArt Graphic: List, Process, Cycle, Hierarchy, 

Relationship, Matrix, Pyramid, or Picture (2010) 

•Add text in the Text pane or in the text boxes within the SmartArt 

Graphic 

•Click the Format tab or the Design tab to display SmartArt Tools 

•Click outside the drawing when you are finished.  

Note: Word 2010 must be in open in .docx file format for the full Smart 

Art Options. If opened in compatibility mode, you will only have limited 

access to Smart Art features 



*In Windows 7, Speech Recognition (SR) is 
built in.

*A good quality microphone ensures accuracy.

*SR can be used wherever a cursor can be 
placed (e.g. Word, email, etc.)

 

Speech Recognition 

In Windows: 

•Start button   Control Panel    Speech Recognition.   

•Also in “Ease of Access Center” 

•Set up your microphone first   Take the speech tutorial 

•Use the speech reference card to learn more commands 

 

*Customize your Quick Access Toolbar (QAT) or 
Ribbon and add the “Speak” button

*Highlight your text and click the button to hear 
your words

*Students can listen and edit their own writing
*(available in MS Word 2010 only)

 

Speak Text 

•Right click on the Word 2010 ribbon to customize either the QAT or 

ribbon.   

•From the “Choose commands from” box, choose “All Commands”    

Scroll down to “speak”  Add    Okay 
 

In earlier versions of MS Word, there is no speak text function.  Use a 

free downloadable add-in called WordTalk from www.wordtalk.org.uk  

http://www.naturalreaders.com

•Assists students who benefit 
from hearing information 
read to them to help with 
comprehension

•Assists students who are 
reading below grade level

•Reads webpages for research

•Control speed in the toolbar

Natural Reader

 

Natural Reader 

•Free application that uses the Windows Text-to-Speech engine to read 

aloud text 

•Click button to use the Floating Bar; it floats over any window 

•Select text    press Play in NaturalReader  

•Text is highlighted as it is read aloud; you can control the speed 

 

Free download from www.naturalreaders.com  

Also check out Readplease from www.readplease.com  

Use the search feature of the navigation pane to easily navigate 
through your document and find repeated words.

 

Navigation Pane 

View Tab   

•Open the Navigation Pane and enter text to search the document 

•Select the last tab of the Navigation Pane to show shortcuts to your 

text 

•Click on text to navigate directly to where it is located in your document 

 

Tip: Search for repeated words and use the right click Synonyms 

feature to find new words   

Word count in status bar

 
Note: View the number of pages and 

words in the document on the status 

bar at the bottom of the workspace. 

Clicking the word count opens the 

Word Count dialog box 

Word Count and Readability  

Use Word Count and Readability statistics to collect data over the 

course of the school year  

•Review Tab  Proofing  Word Count 
 

The Readability Statistics dialog box displays information about the 

reading level of the document. Readability scores are based on the 

average number of syllables per word and words per sentence 

•File Options  Proofing  Check Show Readability Statistics (under 

When correcting spelling and grammar in Word) 

•Review Tab  Proofing  Spelling and Grammar  

•When Word finishes checking spelling and grammar, it displays the 

Readability Statistics dialog box 

http://www.wordtalk.org.uk/
http://www.naturalreaders.com/
http://www.readplease.com/


Give written comments to students or have them edit each other’s work

Prints with or without comments

 

Add Comments 

Review Tab  Comments  New Comment 
 

•Select text or click where you want to insert comment first 

•Write comments in box 
 

To print with or without comments, before printing: 

•Review Tab  Tracking  Drop Down Arrow  Select either Final or 

Final: Show Markup 

From Word or 
PowerPoint, capture 
anything on the screen 
or parts of screen to 
use as motivators or 
publishing tools

Edit the image and 
use it as desired

 

Screen Capture 

Insert Tab  Screen Shot 
 

•Have the window open you want to capture from (any program) 

•From a Word document, go to Insert Tab  Screen Shot 

•You will see thumbnails of each open window 

•To capture the whole window, click on it; to capture a part, click on 

Screen Clipping 

•The clipping will appear in your document as an image 

•With the image selected, go to Picture Tools  Format for picture 

editing tools 

• Use the            button 
to add text effects 
that make your print 
stand out!

• Motivate students to 
write by using special 
fonts.

 

Emphasize Text 

Home  Font  Text Effects  

 

•Text effects previously found in Word Art can now be added to inline 

text 

•Highlight text and choose from shadow, outline or glow 

 

•Use in Word or PowerPoint

•Insert images for students to describe or contrast/compare

•Allow students to publish using the Smart Art for motivation

 

SmartArt (Picture Layouts)  

Insert tab  Illustrations  SmartArt 

 

•Select Picture and choose a SmartArt Graphic 

•Add text in the Text pane or in the text boxes within the SmartArt 

Graphic 

•Click the Format tab or the Design tab to display SmartArt Tools 

•Click outside the drawing when you are finished.  

CAST:  Center for Applied Special Technology  www.cast.org

Multiple means of representation

Multiple means of expression

Multiple means of engagement

 

UDL 

•Multiple means of representation, to give learners various ways of acquiring 

information and knowledge  SmartArt (diagrams), setting the scene 
strategies, auditory feedback through screen readers 

•Multiple means of expression, to provide learners alternatives for demonstrating 

what they know  Speech Recognition, Table to Text, Speak text, using 

navigation pane to search and replace, adding comments on peers’ writing 

•Multiple means of engagement, to tap into learners' interests, offer appropriate 

challenges, and increase motivation  Publishing digitally with opportunities to 

use images and a variety of text formatting, screen shots 

 


